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PatchEZE: "what does it do?"

PatchEZE offers a new means of managing patches for your Gravis UltraSound.    It 
allows you to easily manipulate sets of custom patches for use with DOS or Windows, 
without changing entries in ULTRASND.INI.    You can change the patch that will be used for a 
certain instrument without having to backup, copy or rename patches yourself, yet still have
the normal Gravis patches available for use.

This is done by keeping two directories of patches -- one for all the normal Gravis 
supplied patches from your installation disks, and one for all your custom patches.    When 
you install PatchEZE it copies all of the patches specified in your ULTRASND.INI to a new 
directory.    For this reason, you should check the following before installation:

· No custom patches or "propatches" are installed
· All filenames in ULTRASND.INI refer to the normal Gravis patches
· Patches are in the MIDI subdirectory of the directory specified in 

your ULTRADIR environment variable
This is the state your system should be in if you have not changed 
anything since installation of the UltraSound software.

Because PatchEZE makes new copies of all the Gravis patches, it requires roughly 7 
megabytes of disk space for installation (the patches themselves only take up about 5.5 Mb, 
but space is needed for directories, and the disk pool).    The patches are always copied to 
the PEMIDI subdirectory of the ULTRADIR directory, so that PatchEZE is able to switch this 
directory name with the MIDI directory.    By doing this, it can instantly switch between 
custom or Gravis patches, without changing the patch directory entry in ULTRASND.INI.    
(This entry is left set to the MIDI directory.)

When you install, you will also be asked if you wish to use one of the Suggested 
Patch Management Systems. If you choose to, the installation will create the 
corresponding directory structure.    Please note that there are distinct advantages in using 
one of these systems, as PatchEZE has instrument directory management features.    (See 
Editing Instrument Directories for more information.)



Suggested Patch Management Systems

Having many patches all in one directory can make it very hard to find the patch you 
are looking for. Whilst it is completely up to you as to how you manage your patches, here 
are some suggested systems.    (The base directory referred to is the directory in which 
PatchEZE has been installed.    For example, C:\ULTRASND\PATCHEZE.)

Numerical System
Have directories off the base directory corresponding to melodic and percussive 

program numbers.    For example, MELODIC\000 might contain all the piano patches you like 
to use for program 0: Acoustic Grand Piano.

Advantages: You can quickly and easily find custom patches you like to use for
specific program numbers, without having to worry about how a patch sounds.
Disadvantages: If you want to find a patch, you need to know the program 
number of the instrument you are looking for, which can be annoying. Also, if 
you have special sounds or sound effects, it can be hard to choose where to 
put them, or to know where to find them.

Categorical System
Have more descriptive directories off the base directory.    For example, MELODIC\

PIANO would contain all your piano patches for use with the first General MIDI instrument 
family, and MELODIC\BRASS would have all your brass instrument patches.

Advantages: Finding a patch from a certain instrument family is extremely 
easy.    Sound effects and special sounds can be placed in appropriately named
directories.
Disadvantages: Directories can easily become cluttered with many files and 
you become unsure of which patch matches with which program number.    You
can get around this by changing the .PAT file extension to a numerical 
extension, but then you will need to use the Show All Files option, which can 
be annoying when changing directories.

Combination System
The combination system is the best one to use, as it eliminates the disadvantages of 

using the other systems alone, and is much more versatile.    Patches are arranged in 
descriptive directories, each with a limited range of numerically named subdirectories.    For 
example, off the PIANO directory would be subdirectories 000, 001, ..., 007, whereas off the 
BRASS directory would be 056, 057, ..., 063.

Extra advantages: When you use special instruments not in the General MIDI 
set, you can have numerical subdirectories reminding you of the program 
number you like to use them with.    For example, you may have a directory 
TECHNO\127 reminding you that program number 127 (Gunshot) is rarely 
used and is a good one to replace with your techno type patches.
Disadvantages: Your directory system is quite complicated, and moving 
through directories, particularly in DOS, can be awkward.



PatchEZE Tutorial

Welcome to the PatchEZE tutorial!

This tutorial is aimed towards giving you a better understanding of how
the PatchEZE interface works, and what you should do to get underway

in using PatchEZE to manage your custom patches.    As the tutorial
itself is more of a "getting started" document than interactive training,
you may like to switch between the help window and PatchEZE itself,

to try out each step for yourself.    You may do this quickly with the Alt-
Tab key combination.

Throughout this tutorial you may advance or backtrack through the pages by using 
the >> and << Browse buttons in the help application's button bar.    Alternatively, you can 
go direct to the section you want from the Tutorial Index.



Tutorial Index

The PatchEZE Concept

Mapping Patches - Part One

Mapping Patches - Part Two

Mapping Patches - Part Three

Your Patch Library - Part One

Your Patch Library - Part Two

Advanced Topics



Tutorial:    The Concept

Some More on the PatchEZE Concept

Okay, you've installed PatchEZE, run it, and immediately gotten confused by all the 
menu commands and screen elements.    What do they all do?    Hopefully you have read the 
help section PatchEZE:   "what does it do?"  .    If not, please read it now, to get a basic 
understanding of what PatchEZE is all about.

You know about the two patch directories on your hard drive, but what you might not 
realize is how PatchEZE (and your other software) works with them.    All the patches that are
used by your UltraSound card to play music reside in a directory called MIDI.    Say you 
wanted a completely different set of patches to be used instead of the default ones.    The 
UltraSound drivers support this with what is known as bank switching.    You can create a new
patch bank in the ULTRASND.INI patch information file specifying which patch to use for 
which instrument and where on your hard drive to find these new patches.

The problem with this is that you might end up with a very cluttered and poorly 
organized MIDI directory, or lots of other patch directories on your hard drive containing a 
few patches to use for playback of certain songs.    Also, your new banks won't necessarily 
work with DOS software like games, or the PLAYMIDI program.

An alternative to doing this is to backup the default patches, and then copy the new 
ones you want over the old ones.    (For example, 'COPY GRANDPNO.PAT \ULTRASND\MIDI\
ACPIANO.PAT')    This works well, but still isn't a very good way of managing your patches, 
and it can be quite tiresome changing large numbers of patches in this manner.

What PatchEZE does is similar to this last method in a way.    It copies custom patches
over the top of those in a new directory of patches - the PEMIDI directory.    All the Gravis 
supplied patches in the MIDI directory are left alone, eliminating the need to keep backups of
them.    As you know, PatchEZE switches these two directories around at your request so that
the PEMIDI directory becomes the MIDI directory and vice versa.    (This is done by renaming 
MIDI to some temporary name, then PEMIDI to MIDI, then the temporary name to PEMIDI.)

When you first installed PatchEZE it created the PEMIDI directory holding copies of all 
the Gravis patches.    Therefore, if you switched around the directories straight away, there 
would have been absolutely no difference to the operation of your system or how songs 
sounded when played back with your UltraSound.



Tutorial:    Mapping Patches - Part One

Using a New Piano Patch

If you have not changed anything since installing PatchEZE, then the MIDI directory 
still contains Gravis patches, and the PEMIDI directory contains copies of them.    For a 
custom patch to be heard when you play back songs, you must first map the patch (to the 
PEMIDI directory) and then switch the directories around.

To map the patch, you must first find it on your hard disk - so that the filename is 
displayed in the listbox at the left (the Patch Listbox).    You can double click the directory 
names (shown between square brackets) to change into a different directory until you find 
the patch you want.    For the purpose if this exercise, try to find one of your good piano 
patches.

Next you select the instrument you want to use the patch for in the listbox at the 
right (the Instrument Listbox).    Choose instrument 0.    (If the instrument name listed there 
is not "Acoustic Grand Piano", you will need to select the "Melodic" radio-button at the 
bottom of the PatchEZE window).    Now, all you need to do is click the "Map" button found 
between the two listboxes, and the patch will be copied over ACPIANO.PAT in the PEMIDI 
directory.    (Assuming you haven't already switched the directories around - if you have, then
the patch will go to the MIDI directory.)

This file, ACPIANO.PAT is now just a direct copy of the custom piano patch you 
selected.    However, until the two patch directories are swtched around, this won't be the 
patch used for the "Acoustic Grand Piano" when you play a song with your UltraSound.

Please advance to Part Two.



Tutorial:    Mapping Patches - Part Two

Hearing the Patch in Songs

By now you have mapped a patch to an instrument, and that patch has been copied 
over the top of a patch in the custom patch directory (the PEMIDI directory if you haven't 
already switched the directories around).

As soon as the directories are switched, the PEMIDI directory becomes the MIDI 
directory, and vice versa.    Then, obviously, the patch file that has been overwritten with 
your custom patch resides in the MIDI directory - the place where patches are loaded to your
UltraSound for playing back songs.    So your custom patch will be the one used, instead of 
the default Gravis supplied one.

To switch the directories around, you will notice two radio-buttons at the bottom of 
the PatchEZE window, under the words "Patch directory".    When the "MegaEM" radio-button 
is selected, the MIDI directory contains all Gravis patches.    When the "Custom" radio-button
is selected, it contains the copies of the Gravis patches, and any custom patches you have 
mapped across.    So, if you want the patch you have mapped to be used instead of the 
Gravis one when you play songs, make sure the "Custom" radio-button is selected.    Simple!

Now go on to Part Three



Tutorial:    Mapping Patches - Part Three

Keeping Track, and Putting Things Back to Normal

Once you've mapped a patch and heard it being used in songs instead of the Gravis 
one, you'll probably start wondering how you can keep track of what you have done, and 
how you can go back to using the Gravis patch, whilst still using a custom patch for another 
instrument.

When you click the "Map" button it maps a patch to the selected instrument.    Below 
this button is another one marked "Gravis".    The "Gravis" button can be thought of as 
undoing the operation of the "Map" button, because clicking this button will map the Gravis 
supplied patch to the selected instrument.    You might ask why you should use this button, 
rather than finding the Gravis patch on your hard drive and using the "Map" button to 
achieve the same effect.    For one, it is quicker and easier.    There is another reason, but it is
an advanced topic - for now just take it on good faith.

Keeping track of what you have done in previous instances of PatchEZE is just as 
easy - simply take a look at the Instrument listbox!    All the entries are coloured according to
what sort of patch has been mapped across to that instrument.

Before you actually do anything in a certain instance of PatchEZE, each instrument 
can be one of three colours.    Normal patches are coloured in BLACK, and those instruments 
for which no patch is being used (such as some percussion instruments not in the General 
MIDI standard) are coloured GRAY.    If any instrument name is coloured RED, it means that 
you have mapped a patch to that instrument at some other time.

If you have been experimenting with mapping patches already, you may like to try 
this out by mapping a patch with the "Map" button, exitting PatchEZE, and then running it 
again to see that the instrument name is now coloured red.

There are two other colours that you have most likely noticed by now.    Whenever 
you click the "Map" button or the "Gravis" button, the instrument name changes colour, to 
GREEN with the "Map" button and BLUE with the "Gravis" button.    This just lets you know 
what you have done during the current instance of the program.    (Note that any instrument 
coloured green when you exit PatchEZE will be coloured red when you run the program 
again.)

Next in the tutorial is "Your Patch Library"



Tutorial:    Your Patch Library - Part One

PatchEZE as a Librarian

PatchEZE provides two main library maintenance features - the instrument 
directories, and the patch descriptions.    The instrument directories let you organize and 
separate patches into groups depending on what instrument or sort of instrument they 
should be used for.    Patch descriptions let you see at a glance how a patch sounds, without 
having to listen to it.    This is quite useful for looking through a long list of patches to decide 
which to use.

PatchEZE allows you to keep your patches in separate directories depending on which
instrument you like to use them for.    When you installed PatchEZE, you may have set up 
one of the Suggested Patch Management Systems.    This would have created a set of 
these "instrument directories" on your hard drive - directories named after instrument family
names, instrument numbers, or both.

There are two features for managing patches and these instrument directories.    The 
"Zoom to Dir" button is provided for instantly changing to the directory for the currently 
selected instrument.    This means that anytime you want to find all your substitute patches 
for a certain instrument, all you have to do is select it and hit this button.

Also provided is the "Install" button.    This copies the selected patch from the listbox 
at the left to the directory for the selected instrument.    (Actually, any file can be copied, not
necessarily just patch files.)    Obviously, the "Install" button lets you quickly sort your 
patches into correct sections on your hard drive.    PatchEZE also has the Install Moves File
option (found in the Options menu), and if this is turned on, using the "Install" button will 
actually move the file to the selected instrument directory.    Otherwise, it will only be copied 
(left in the original location as well as the copy in the instrument directory).

Please advance to Part Two.



Tutorial:    Your Patch Library - Part Two

Patch Descriptions

As mentioned in the previous section, you can use patch descriptions in PatchEZE for 
including inside each patch file, a description of what the patch sounds like.    Two description
fields are provided for - a short, 16 character one, and a longer, 60 character one.    (Note 
that most of the time the long description is used for copyright information.    You are able to 
edit it with PatchEZE in case you want to use it for more detailed descriptions than the short 
description field allows for.)

The short description is included next to the name of each patch file in the patch 
listbox at the left side of the screen.    The long description is displayed for the currently 
selected patch in the "Description" edit control beneath the two listboxes.    (Note that if the 
instrument listbox has the input focus, this edit control is used for editing the instrument 
names.)

To modify the short description for a patch, first select the one you want changed, 
and then choose Set Short Description from the Edit menu.    You will be prompted for the
new description.    Changing the long description is even easier - select the patch file, and 
then click the mouse in the "Description" edit control.    Edit the text in the normal way 
(cursor keys, insert, delete, backspace, and the alphanumeric keyboard keys), and then click
the "Save" button immediately to the right of the edit control.    The description will then be 
permanently save to that patch file.    (Note that the "Save" button only becomes active once
the text in the edit control has been changed.)

Next in the tutorial is "Advanced Topics"



Tutorial:    Advanced Topics

Now is the time for you to learn more about PatchEZE from the normal reference 
sections of the help file.    It is suggested that you progress through these topics in the order 
listed, although you need not necessarily do so.

The first topic listed, on the PatchEZE screen interface, should be used simply to let 
you know what each screen element (control) is for.    You should avoid reading most of the 
cross reference topics given unless you need to.    Rather, try to only gain a basic 
understanding of what each control is for, and return to this list of advanced topics to 
progress further.

The PatchEZE Display

Auditioning a Patch

Editing Instrument Names

Editing Instrument Directories

What is the Instrument Status?

Opening and Saving Patch Sets

Mapping Patches

Duplicating Mappings



Registration

PatchEZE is not free, but is marketed under the shareware "try before you buy" 
concept.    You are granted a licence to use it for a trial period of 14 days.    If you decide that 
you wish to continue using it beyond this time, you MUST register.    After the 14 day 
evaluation period you are required to purchase the software to continue using it.    If you 
wouldn't steal software from a store, don't steal this software by failing to register!

Registration only costs $US15 or $A20 for an individual licence.    If PatchEZE is being 
used in a business or organization, then a corporate/company licence must be purchased 
($US200 or $A250). These licences are valid state-wide.    That is, if your business or 
organization spans different states or countries, a separate registration is needed for each 
state or country in which the software is to be used.    Please also note that a registration of 
this type does not grant a licence to any employee to use the software for personal 
purposes.    (A separate registration is required.)

The preferred form of payment is a post office money order, or a cashier's check.    
Personal checks will be accepted, but you will not receive your registration code until the 
check has been cleared.    For this reason it is better for you to use one of the other methods.
(Post office money order or cashier's check.)    If you send cash you do so at your own risk.    
Once you have registered you will not need to register updated versions - it is a lifetime 
registration.    Please note that you will be unable to receive customer support if you do not 
register.

Please include the completed Registration Form to register.

Registrations to:
Registrations (PatchEZE)
Software Hallucinations
3 Bridget Place
Shelley, Perth
WESTERN AUSTRALIA
6148



PatchEZE Registration Form

(Please select Print Topic from the File menu to print out this form)

 Individual Registration ($US15 or $A20)
 Corporate/Company Registration ($US200 or $A250)

Personal information (contact person if corporate/company):

Title: ______________ Surname: _______________________________
                    Please use BLOCK capitals

Given names: _________________________________________________________________

Occupation: _________________________________________________________________

Internet email (if applicable): ___________________________________________________
 Check this box to be sent your registration details via email.

Mailing information (business address if corporate/company):

Address: _________________________________________________________________

Country: ________________________ City/town: ________________________

State: ________________________ Postal code: ________________________

Phone (home): ________________________ Phone (work): ________________________

Corporate/company only:

Business name: ______________________________________________________________

Nature of business: ______________________________________________________________

The following section is optional.    You do not have to complete it.

Computer (please mark correct box/s):
 Pentium

 486
 386
 286
 Other

 DX
 SX

Speed (MHz): ________________________ Hard disk (Mb): ________________________

Memory (Mb): ________________________

Comments on PatchEZE: ____________________________________________________



________________________________________________________________________________

________________________________________________________________________________



Disclaimer and Copying Agreement

PatchEZE is provided "AS IS", without warranty of any kind, either express or implied. 
This includes, but is not limited to, the implied warranties of merchantability and/or fitness 
for a particular purpose.    Also, Software Hallucinations assumes no liability for direct, 
indirect, special or consequential damages to hardware or software (including but not limited
to loss and/or corruption of data) arising from the use of this program or its failure to operate
in a way so desired by its user.    The entire risk as to the quality and performance of 
PatchEZE is with the user.

Under no circumstances will Software Hallucinations be liable for any monetary or 
material damages, including lost profits or savings, or other incidental or consequential 
damages arising from the user's ability or inability to use PatchEZE, or for any claim made 
by any other party. 

Note:    The title "PatchEZE" is used above in reference to the entire PatchEZE 
package.    The use of "PatchEZE" therefore includes the use of any of its individual program 
files.

PatchEZE may be freely copied and distributed providing the following conditions are 
adhered to:

· No charge may be made for the distribution of the software other 
than the cost of the transmitting medium.    (No charge other than 
the cost of the disk.)

· All files from the original archive, if not the archive itself, must be 
distributed together, in a way such that the software can be 
installed. (That is, all together in one single directory on the disk or 
in the archive.)

Microsoft, DOS, and Windows are registered trademarks of Microsoft Corporation.    Gravis UltraSound is a 
registered trademark of Advanced Gravis Computer Technology Ltd.    All other trademarks, registered trademarks 
and copyrights are the property of their respective owners.



The PatchEZE Display

Please click the display area on which you would like information.



PatchEZE

Thankyou for trying PatchEZE.    Please do not forget to register if you wish to use it for more 
than 14 days.    For more information, see Registration.



                                  File Menu

From the File menu you can open or save different patch sets, delete and rename files, or exit 
PatchEZE.

See also:
Opening and Saving Patch Sets
Deleting Files
Renaming Files



                            Edit Menu

The Edit menu contains selections for various editing features.    From it you can change a patch's
short description field, or an instrument's status or instrument directory.    You can also reset all 
the instrument names to the original ones, duplicate instrument mappings, display the mapping 
information for the selected instrument, or cache all drum patches.

See also:
Editing Patch Descriptions
Setting Instrument Status
What is the Instrument Status?
Editing Instrument Directories
Resetting Instrument Names
Duplicating Mappings
Showing Mapping Information
Caching All Drum Patches



        Help Menu

Use the Help menu to get help information on how to use PatchEZE.



                        Directory Static

The directory static displays the directory in which the patches from the Patch Listbox are found.



Patch Listbox

The Patch listbox is where you select a patch to map to a certain MIDI instrument.    It displays 
the filename and the short description for that patch.    Double clicking a directory entry will 
change into that directory.

See also:
Auditioning a Patch
Editing Patch Descriptions



Instrument Listbox

The Instrument listbox is where you select the MIDI instrument to map the patch from the Patch 
Listbox onto.    It displays the melodic or percussive instrument names.    The entries are coloured
according to the instrument status - green for "remapped", blue for "gravis", dark gray for 
"undefined", and red for instruments for which custom patches are already installed (when you 
start PatchEZE).    Note that those coloured red still have the "unchanged" status.

If the display is the mapping list mode, the Instrument listbox also displays the patch filename in 
the patch working directory, the short description, and the instrument status for each MIDI 
instrument.    (Note that the description is taken from either the normal Gravis patch, or the 
custom one in the patch working directory, depending on the state of the Patch Directory Radio-
Buttons.)

See also:
Auditioning a Patch
Editing Instrument Names
Display Radio-Buttons
What is the Instrument Status?



Size Static

The size static displays the file size in kilobytes for the selected patch in the Patch Listbox or the 
Instrument Listbox, depending on which has the input focus.    (You can tell which this is by the 
position of the size static -- it is always just above the upper right hand corner of the correct 
listbox.)    Note that sizes are not displayed for directories and non patch files in the Patch 
listbox, or if the file does not exist (instrument has "Undefined" status).

See also:
What is the Instrument Status?



Map Button

Click the Map button to map the selected patch file in the Patch Listbox onto the selected MIDI 
instrument in the Instrument Listbox.    When you click this button the file is copied over the 
corresponding patch in the patch working directory.    Note that the Map button is grayed out if 
the selected file is not a valid patch file.

You should avoid mapping patches from the MIDI or PEMIDI directories (or any subdirectories 
of them), as when you load a patch set with such mappings, the required patch could be in the 
other directory due to directory switching.    (See Patch Directory Radio-Buttons.)    To map the 
normal Gravis patch to a certain instrument, you should use the Gravis Button instead.

See also:
Mapping Patches



Gravis Button

The Gravis button is very similar to the Map Button, except the normal Gravis patch for the 
selected MIDI instrument is copied to the patch working directory.    This button should be used 
instead of manually mapping the required patch, as it ensures Gravis mapped patches will be 
copied correctly when a patch set is loaded.    (If a patch set contains mappings from the MIDI or 
PEMIDI directories, the required patch could be in the other directory when the patch set is 
loaded again, due to directory switching.    Please see Patch Directory Radio-Buttons for more 
information.)

See also:
Mapping Patches



Install Button

You may wish to keep all your patches in separate directories depending on which instrument 
they are used for, such as with the Suggested Patch Management Systems.    This is especially 
useful when you have a large number of patches.    However, navigating through these directories
and copying the right patches to them can be a daunting task.    PatchEZE greatly simplifies this 
with the Install button and the Zoom to Dir Button.

Clicking the Install button will copy the selected patch file in the Patch Listbox to the appropriate
directory for the instrument selected in the Instrument Listbox.    If no instrument directory is 
defined, you will be asked to enter one.    Note that if you installed one of the suggested patch 
management systems when you first installed PatchEZE, these directories will be set up for you 
(for most instruments).    Also note that ANY file can be copied with the Install button, regardless
of whether it is a valid patch file or not.

See also:
Install Button Moves File
Editing Instrument Directories



Zoom to Dir Button

You may wish to keep all your patches in separate directories depending on which instrument 
they are used for, such as with the Suggested Patch Management Systems.    This is especially 
useful when you have a large number of patches.    However, navigating through these directories
and copying the right patches to them can be a daunting task.    PatchEZE greatly simplifies this 
with the Zoom to Dir Button and the Install Button.

Whilst the Install button copies the selected patch to the appropriate directory for the selected 
instrument, the Zoom to Dir button will change into that directory.    Thus, if you want to find the
patches you use for a certain instrument, simply select that instrument in the Instrument Listbox 
and click the Zoom to Dir button.    If no instrument directory is defined, you will be asked to 
enter one.

Once the Zoom to Dir button has been clicked, it will change to read "Previous Dir".    Clicking 
the button when it is in this state will take you back to the directory you were in before you 
clicked Zoom to Dir.    (The button changes back to Zoom to Dir again when you change 
directories manually or select a different instrument in the Instrument Listbox.)

See also:
Editing Instrument Directories

(Note that the "Previous Dir" state of the Zoom to Dir button is only active once you have 
registered.    See Registration for more information.)



Description Edit

If the Patch Listbox receives the input focus, or the display is the mapping list mode, then the 
Description edit shows the long description (60 characters) for the selected patch.    Note that in 
mapping list mode the Description edit serves only to display the patch description and that 
editing it is disabled.

If the Instrument Listbox receives the input focus and the display is the patch selection mode, 
then the Description edit shows the instrument name (22 characters).

See also:
Save Button
Display Radio-Buttons



Save Button

Click the Save button to save changes made in the Description Edit control.    If the text is an 
instrument name, saving it simply updates the text in the Instrument Listbox. Otherwise the text 
is a long description, and it is saved to the patch file selected in the Patch Listbox.    Note that the
Save button does not become active until changes are made to the text in the edit control.



Display Radio-Buttons

PatchEZE has two display modes -- patch selection mode and mapping list mode.    The Display 
radio-buttons switch between them.    Patch selection mode is the normal screen used for 
mapping patches to instruments.    Mapping list mode lets you see which patches are currently 
available for use as instruments.    For more information, see Instrument Listbox.



Patch Availability

The word "available" when used to refer to patches means the patch will be used in MIDI songs 
you hear.    In other words, the patch has the correct filename, and is either in the Gravis patch 
directory and the MegaEM button is selected, or the patch has been copied to the patch working 
directory and the Custom button is selected.

See also:
Patch Directory Radio-Buttons



Patch Set Radio-Buttons

The Patch Set radio-buttons allow you to select either the melodic set or the percussive set to 
map patches onto.    (That is, for display in the Instrument Listbox.)



Patch Directory Radio-Buttons

PatchEZE works with two directories -- your Gravis patch directory, and your patch working 
directory (for custom patches).    The directory names MIDI and PEMIDI are switched so that, at 
a certain time your custom patches may be in the MIDI directory, and at another, they may be in 
the PEMIDI directory.

This provides the greatest compatibility with existing software and the Windows drivers, because
some programs always look in the MIDI directory for patches.    For example, this allows you to 
play songs with PLAYMIDI using your custom patches, and then switch the directories and use 
programs like MegaEM, which require the Gravis patches to be in the MIDI directory.

Select MegaEM to make the Gravis patches available (for use with emulators and other software 
that require the default patches), and Custom to make your custom patches available.

See also:
Using PatchEZE With MIDI Programs
DIRSET: The PatchEZE DOS Utility
Tutorial: The Concept



Note and Octave Statics

The Note and Octave static controls display the current play note and octave for Auditioning a 
Patch with the Audition Button.    If you use an external MIDI keyboard, these change according
to the MIDI note you play.    Also, when you load a patch for auditioning, they change to a 
suggested note for that patch.    (This is really only for percussive patches, and you must turn 
Melodic Note Suggest on for it to happen with melodic patches loaded from the Instrument 
Listbox.)

See also:
Audition Scrollbar
Audition Keyboard



Audition Button

Clicking the Audition button lets you play the note specified with the Note and Octave Statics 
and the Audition Scrollbar.    The note will play whilst the button is held down with either the left
mouse button or the spacebar.

See also:
Auditioning a Patch
Audition Keyboard



Audition Scrollbar

Use the Audition scrollbar to select the play note and octave that will be used for Auditioning a 
Patch with the Audition Button.

See also:
Audition Keyboard



Procedures: "how do I...?"

Mapping Patches Duplicating Mappings

Auditioning a Patch Opening and Saving Patch 
Sets

Deleting Files Renaming Files

Using PatchEZE With 
MegaEM

Using PatchEZE With MIDI 
Programs

Editing Instrument Names Editing Patch Descriptions

Setting Instrument Status Editing Instrument 
Directories

Resetting Instrument Names Showing Mapping 
Information

Caching All Drum Patches

Mapping Patches

The whole idea of PatchEZE is to enable you to manage custom patches and change 
the patch that will be used for a certain instrument without having to backup, copy, or 
rename patches yourself.    It works with the MIDI and PEMIDI subdirectories of the directory 
specified in your ULTRADIR environment variable.    One of these is the Gravis patch 
directory, and the other is your patch working directory (for custom patches).    Switching 
these directories around with the Patch Directory Radio-Buttons lets you switch between the 
custom or Gravis patch set.    (Please see Tutorial: The Concept for more information.)

The Patch Listbox is where you change directories and select a patch to map onto the
instrument you have selected in the Instrument Listbox.    Clicking the Map Button will copy 
the selected patch over the correct instrument patch in the patch working directory.    The 
full path and filename of this patch is stored in the mapping information for that instrument, 
and this is what is written to patch sets you save.    When you map a patch to an instrument, 
that instrument's status becomes "Remapped".    If the instrument is "Undefined" you may 
need to enter a name for the file it will go to in the patch working directory.    (See Define 
With Filename.)

If you map a patch from the MIDI or PEMIDI directories and save that mapping to a 



patch set, when you try to load the patch set again, the patch might not be copied.    This is 
because the MIDI and PEMIDI directories are always being switched around so that the patch
you originally mapped across could be in either directory.

For this reason you should NOT map patches from the MIDI or PEMIDI directories (or 
any subdirectories of them).    The Gravis Button is provided to allow you to map the original 
Gravis patch onto an instrument, and should be used when you want to do this.    (The word 
<GRAVIS> is then stored in the mapping information, rather than the path and filename of 
the patch.)    If you want to map a certain instrument's patch onto a different instrument 
without having to find the original patch file again, you should use the Duplicate Mapping 
selection from the Edit menu.

See also:
What is the Instrument Status?
Tutorial: Mapping Patches - Part One



Duplicating Mappings

It is quite possible that you may wish to use the same patch for two different 
instruments.    To simplify this, and to prevent you from having to manually map the patch 
file across twice (once for each instrument), PatchEZE provides the Duplicate Mapping 
selection of the Edit menu.

When you go to duplicate a mapping, you will first be asked to select the SOURCE 
instrument (the instrument that already has the desired mapping), and then the 
DESTINATION instrument (the instrument you want to also have that mapping).    Just use the
Instrument Listbox to choose each instrument, and then click the "Ok" button.

Please note that the source instrument MUST be defined for its mapping to be 
duplicated.    That is, it cannot have the "Undefined" status.    If the second instrument is 
"Undefined", you may need to enter a name for the file it will go to in the patch working 
directory.    (See Define With Filename.)    Also if the Gravis patch was mapped to the first 
instrument using the Gravis Button, and the second instrument has no Gravis supplied patch
(as for percussive instruments 0-26 and 88-127), then the mapping cannot be duplicated.

The Duplicate Mapping selection is grayed out (disabled) when the display is in 
mapping list mode. (See Display Radio-Buttons.)

See also:
What is the Instrument Status?



Auditioning a Patch

With PatchEZE you can audition patches on disk so that you can hear what they 
sound like before you map them to instruments.    To audition a patch, you must first load it 
to your UltraSound card.    This is done by double clicking a patch in the Patch Listbox or 
instrument name in the Instrument Listbox.    Alternatively, you can press enter when the 
listbox has the input focus and the patch or instrument you want to hear is selected.

Once the patch is loaded you can audition it with an external MIDI keyboard, or by 
moving the Audition Scroller to get the note you want displayed in the Note and Octave 
Statics, and then clicking the Audition Button.

If you have registered PatchEZE, you will also be able to use the Audition Keyboard
to listen to patches.

Some patches (such as many percussive ones) are only defined over a limited range 
of notes, so PatchEZE suggests a play note and octave to save you having to hunt around for
the correct note before you can hear the patch.    See Melodic Note Suggest for more 
information.

See also:
Caching All Drum Patches



Opening and Saving Patch Sets

PatchEZE patch sets contain the instrument names and mappings for some or all the 
instruments.    Each instrument's mapping information is simply the full path to the patch file
to use for that instrument.

Current mappings are loaded from PATCHEZE.INI whenever you run PatchEZE, and 
saved each time you exit.    When you open a patch set, each mapping is compared to the 
current one to see if it is necessary to perform the mapping by copying the requested patch. 
To save time in opening a patch set, the patch is only copied if necessary.

When you save a patch set, you will be presented with a dialog box asking which 
instruments and which instrument mappings to include.    You can select melodic, percussive,
or all instruments, and to either save all mappings, or a combination of those with the 
"Gravis" status, the "Remapped" status and the "Unchanged" status.    You can also select 
not to include the instrument names in the patch set if you so desire.    (When you open a 
patch set that does not include instrument names, the current names will be preserved.)

If you enter the filename of an existing file, you will be asked if you wish to overwrite 
it or not.    Choose "No" to select a different filename.    If you choose "Yes", you will then be 
asked whether to actually overwrite, or to just append and modify mappings already in the 
file.    If you are trying to add a new mapping to a patch set you have previously saved, 
choose append (the "Yes" button).    Otherwise, choose overwrite (the "No" button), and the 
existing file will be erased before the patch set is saved.

To open a patch set, select Open Patch Set from the File menu.    To save a patch 
set, select Save Patch Set from the File menu.

See also:
Revert To Gravis



Deleting Files

You can delete the currently selected file in the Patch Listbox by choosing Delete 
from the File menu.    Please note that files are deleted regardless of their attributes.    (That 
is, files will be deleted even if they are read only.)

See also:
Query On Delete



Renaming Files

You can rename the currently selected file in the Patch Listbox by choosing Rename 
from the File menu.    This will bring up an edit dialog prompting you for the new filename.



Using PatchEZE With MegaEM

If the patches in your MIDI directory are custom patches, you may find that some 
DOS programs, such as MegaEM, will not work correctly.    This is because they download a 
certain set of patches to your UltraSound card, depending on how much memory you have 
installed on it.    Custom patches may not be the same size as the normal Gravis ones, and 
so the program is unable to load the correct set of patches.

If you encounter any problems with programs expecting Gravis patches, select the 
MegaEM button in the Patch Directory Radio-Buttons.    This will make ensure the correct 
patches are available.

See also:
Using PatchEZE With MIDI Programs



Using PatchEZE With MIDI Programs

You may like to keep PatchEZE open whilst you use other MIDI programs to compose 
or playback music.    If this is the case, it is strongly recommended that you do NOT attempt 
to load a patch for auditioning whilst another program is playing back music, as it may cause
problems for that program.    MIDI thru modes in other programs may also cause problems 
with PatchEZE's MIDI thru mode.

In addition, if you want to listen to music with the Gravis patches, then switch the 
patch directories around and listen to it with your custom patches, you need to remember 
that the other program may not reload patches every time it plays music.    This means that 
you will not be able to simply click the MegaEM or Custom button from the Patch Directory 
Radio-Buttons and expect that when you start the music playing again it will play with the 
other patches.    (Also, if the music is playing when you switch directories, it will not suddenly
start playing with the other patches.)

How you get the other program to acknowledge the change and reload the patches 
again is dependent on that program.    If there are 'reload patches' or 'reset device' 
commands, try choosing those.    Otherwise, you might need to go into the program's MIDI 
setup again and reselect the MIDI output device (this works for Midisoft® Recording 
Session).    As a last resort, you may have to reload the MIDI file (this has to be done for the 
Media Player application).

See also:
Auditioning a Patch



Editing Instrument Names

PatchEZE allows you to change the instrument names displayed in the Instrument 
Listbox.    This is mainly used for when you have an instrument not included in the General 
MIDI set, so there is no appropriate instrument name.    Instrument names are loaded from 
PATCHEZE.INI whenever you run PatchEZE, and saved when you exit.    They are also 
included in patch sets that you save.

To change an instrument name, select the instrument in the Instrument listbox, and 
you will see the name appear in the Description Edit.    After changing the text in the edit 
control to the new instrument name, click the Save Button to keep changes.    Names can be 
up to 22 characters in length.

See also:
Opening and Saving Patch Sets
Resetting Instrument Names



Editing Patch Descriptions

Patch files have two description fields -- a short one of 16 characters in length, and a 
longer one of 60 characters.    The long description is normally used for copyright 
information.    However, you may like to use it to include more detailed information on how 
each patch sounds.    (16 characters does not let you include very much information.)

The long description is displayed in the Description Edit when a patch is selected and 
the short description is displayed next to patch files in the Patch Listbox.    To edit the short 
description, you need to select Set Short Description from the Edit menu.    To change the
long description, simply edit it in the Description edit control and click the Save Button to 
save changes to the patch file.

The Set Short Description menu item is grayed out if the patch selected in the 
Patch listbox is not a valid patch file (or is a directory).



Setting Instrument Status

Suppose you have loaded a patch set that redefines program 0 (Acoustic Grand 
Piano), and have then quit PatchEZE.    Later on you might decide that you wish to add this 
mapping to another patch set containing some of your favourite instruments, so that you 
know loading this special patch set will guarantee your new piano patch is available.    To add
the piano mapping, you run PatchEZE and load this other patch set.

Now, you want to add this piano mapping, but the instrument status for program 0 is 
"Unchanged" because you have only just started PatchEZE.    There are two ways you could 
get the mapping to save to the patch set -- either save all instruments with the "Unchanged"
status, or remap that patch again so the status becomes "Remapped".    (Please see 
Opening and Saving Patch Sets for more information.)

Saving all those with the "Unchanged" status would mean most or all mappings 
would be included in the patch set.    Every time you loaded the patch set, most or all of your
patches would be copied to your patch working directory.    Depending on your disk speed, 
this could be extremely slow!

Remapping the patch again is a ridiculous thing to have to do, because it copies the 
custom patch to the patch working directory even though it is already there!    This is the 
reason for the very important point:

If you know the patch currently available for a certain 
instrument is the one you want included in a patch set, but 
that instrument's status is "Unchanged", you can simply 
set the status to "Remapped" so that you can ensure the 
mapping is saved to the patch set.

To set an instrument's status, simply choose Set Instrument Status from the Edit 
menu.    Please note that you can only change between "Gravis", "Unchanged" and 
"Remapped", and not the "Undefined" status.    (The menu item is grayed out if the selected 
instrument has the "Undefined" status.)    You may like to switch "Gravis" to "Remapped" or 
vice versa if you have many mappings of either type but only wish to include some of them 
in a saved patch set.

Please note that changing the status does NOT change the mapping information 
itself.    Changing "Remapped" to "Gravis" will not set the patch mapping information to 
specify the Gravis patch for that instrument.    (The mapping information for each instrument
is the full path and filename of the patch file to use, or <GRAVIS> for Gravis patches.    You 
can check what it is set to with the Show Mapping Information selection of the Edit 
menu.    If you change all "Remapped" instruments to "Gravis", save only those "Gravis" ones
to a patch set and then load that patch set again, the patches copied won't be the Gravis 
patches!)

See also:
What is the Instrument Status?
Opening and Saving Patch Sets
Mapping Patches
Revert To Gravis



What is the Instrument Status?

In PatchEZE, each instrument has its corresponding mapping status.    This status is 
primarily used to let you select which mappings to save when you save a patch set, and can 
be seen in the Instrument Listbox when the display is in mapping list mode.    When you first 
start PatchEZE, each instrument status is set to "Unchanged".    The status can be one of the 
following:

"Undefined" There is no entry in ULTRASND.INI for this instrument.    Unless you 
modify ULTRASND.INI outside of PatchEZE, you should only ever see this status for 
percussive instruments 0 to 26 and 88 to 127.    If an instrument is undefined and you 
attempt to map a patch to it, you will be asked to enter the filename in the patch working 
directory to use, unless the Define With Filename option is on.    Once an instrument 
becomes defined and no longer has this status, you should not see the "Undefined" status 
for it again.

"Unchanged" The patch in the patch working directory has not been changed during 
this instance of PatchEZE.    (That is, you haven't mapped a patch to the instrument during 
this PatchEZE session.)

"Remapped" The patch in the patch working directory has been changed during this 
instance of PatchEZE.    (That is, you have mapped a patch to the instrument during this 
PatchEZE session.)

"Gravis"                    The normal Gravis patch has been mapped to the instrument 
during this PatchEZE session.    (Note that this is similar to "Remapped", except the Gravis 
patch has been copied and the mapping information is <GRAVIS> rather than the full path 
and filename of the patch file.    This status is only included for the special case of saving a 
patch set of only Gravis patch instrument mappings.    Read the help on the Gravis Button for
more information.)

See also:
Setting Instrument Status
Opening and Saving Patch Sets



Editing Instrument Directories

When you have a large number of patches, you may wish to organize them into 
separate directories depending on which instrument you like to use them for, such as with 
the Suggested Patch Management Systems.    Whilst this is a good way of managing 
patches, it can be difficult to navigate your way through these directories, or copy patches 
to them.    PatchEZE assists you by providing instrument directory management features.

Every instrument has a corresponding directory defined in PATCHEZE.INI.    The Install 
Button lets you select a patch and instrument, and then copy (install) the patch to the 
correct directory.    The Zoom to Dir immediately takes you to the directory for the selected 
instrument, taking away the hassle of trying to find it on your disk.

If you installed one of the suggested patch management systems when you first 
installed PatchEZE, directories will be set up for you for all instruments.    Otherwise, the 
directories will be undefined.

If no directory is defined for the selected instrument and you attempt to copy a patch
with the Install button, or change directory with the Zoom to Dir button, you will be 
prompted to select a new instrument directory.    However, you may like to set a directory 
manually.    In this case, select Set Instrument Directory from the Edit menu.



Resetting Instrument Names

Sometimes you may want to start afresh and have all instrument names set to their 
normal General MIDI name.    In this case, simply select Reset Instrument Names from the
Edit menu.    This will load all the original names that you saw when you first installed and 
ran PatchEZE.    (Names will not be changed for those instruments not having a normal 
General MIDI name specified in PATCHEZE.INI.)



Showing Mapping Information

It is sometimes useful to know exactly what file on disk has been mapped to a certain
instrument.    This, the mapping information, is not displayed in the Instrument Listbox when 
the display is in mapping list mode.    (See Display Radio-Buttons for more information.)

To display the mapping information for the selected instrument, choose Show 
Mapping Information from the Edit menu.    Mapping information cannot be shown for 
"Undefined" instruments, so if the selected instrument has this status, this menu item will be
grayed out (disabled).

See also:
What is the Instrument Status?



Caching All Drum Patches

For those of you that love to bang out drum rhythyms on your keyboard, the Cache 
All Drum Patches selection of the Edit menu is provided.    Selecting this caches as many 
of the percussion instruments as will fit into the memory on your UltraSound card, and sets 
the MIDI output channel to 10, so that you can audition all (or most) of the drum patches at 
once.

This is especially useful for creating large drum sets as replacements for the normal 
Gravis supplied set of patches.    For example, if you were replacing patches with those from 
the TR-808 percussion set.

(Note:    If you are using the Audition Keyboard then you can still use the single key
chord play and chord recognition features with all the drum patches loaded, although the 
features are no longer useful.)

See also:
Auditioning a Patch



Options

Show All Files

Melodic Note Suggest

Define With Filename

Install Button Moves File

Revert To Gravis

Query On Delete

Audition Keyboard

MIDI Input Device



Show All Files

By default PatchEZE only displays files with the .PAT extension in the Patch Listbox. 
However, you may like to rename your patches with a numeric extension corresponding to 
the General MIDI program number you use it for, or with some other non standard extension 
you find useful.    In this case you will want all files to be shown, so you must turn on the 
Show All Files option.

See also:
Editing Instrument Directories



Melodic Note Suggest

Some patches may only be defined for a limited range of notes.    For example, many 
percussive patches are only defined for the note corresponding to their General MIDI 
program number.    When you load a patch ready for auditioning, PatchEZE will suggest a 
play note and octave and will update the Note and Octave Statics and Audition Scrollbar 
accordingly. This saves you having to hunt around to find a note that will let you actually 
hear the sound.

PatchEZE will always suggest a note in this way for patches loaded from the Patch 
Listbox and for percussive patches loaded from the Instrument Listbox.    If you want it to 
suggest for melodic patches as well, you must turn on the Melodic Note Suggest option.

See also:
Auditioning a Patch



Define With Filename

When you try to map a patch to an instrument with the "Undefined" status, PatchEZE 
doesn't know what filename to copy the patch to in the patch working directory.    If the 
Define With Filename option is turned off, you will be asked for a suitable filename.    
Turning this option on will cause PatchEZE to use the original name of the patch if possible.    
(If a file with that name already exists in the patch working directory, then you will be 
prompted for a filename as if this option were off.)

See also:
What is the Instrument Status?



Install Button Moves File

When you copy a patch to an instrument directory with the Install Button, you may 
not wish for the original file to be left on your disk.    That is, you want the file MOVED to the 
instrument directory, rather than copied.    (Moving a file means the original is deleted after 
the copy operation.)

PatchEZE supports this with the Install Button Moves File option.    Turning this 
option on will result in the original file being deleted after it has been copied with the Install 
button.

See also:
Editing Instrument Directories



Revert To Gravis

You may wish to keep your patch working directory "clean" so that it contains only 
Gravis patches and a few custom patches according to the currently loaded patch set.    In 
other words, whenever a new patch set is loaded, you want all instruments not defined in 
the patch set to be set to Gravis patches.    This is done with the Revert To Gravis option.

If this option is turned on, PatchEZE checks the current mapping information for every
instrument not having a new mapping defined in the patch set being loaded.    If the current 
instrument mapping is not already <GRAVIS>, then a custom patch must already be loaded 
for that instrument, and so the Gravis patch is copied across.

Note that the recommended way of setting all patches in the patch working directory 
to Gravis patches is to simply load an empty patch set (no mappings) with this option turned
on.    You should preferably NOT just copy the patches again in DOS, as this doesn't change 
the mapping information PatchEZE has stored.    (It is also slower!)

Also, loading patch sets with DIRSET will be considerably slower with this option 
turned on, even if no Gravis patches have to be copied.    (This is because the mapping 
information has to be read from PATCHEZE.INI for every instrument, not just those being 
remapped.)

See also:
Opening and Saving Patch Sets
Setting Instrument Status



Query On Delete

As an added security measure to prevent you from accidentally deleting your special 
patches with the Delete command of the File menu, you may like to use the Query On 
Delete option.    This just asks for confirmation every time you try to delete a file.

See also:
Deleting Files

(Note that this option only becomes active once you have registered.    See Registration for
more information.)



Audition Keyboard

Another way to audition patches is by using the audition keyboard, which looks like 
the picture below.

Clicking on the keys with the left mouse button will play that note, or a combination 
of notes if you have selected an Audition Chord to play.    When playing with an external 
MIDI keyboard, if you have selected Chord Recognition, then PatchEZE will display the 
name and note of the chord you are playing if it is able to detect one.    (If an individual chord
has been selected you can also play chords with the touch of a single key on your external 
keyboard.)

The program number displayed on the picture of the keyboard lets you know what 
instrument is currently loaded for auditioning, and the program type light next to it shows 
whether the patch is a melodic, percussive, or custom (unknown) one.    The number 
changes when you load a patch for auditioning by double clicking instruments in the 
Instrument Listbox to the number of the instrument you selected.    If you load a patch from 
the Patch Listbox then the number becomes set to "- - -", and the program type light set to 
CUSTOM.

See also:
Auditioning a Patch

(Note that the Audition Keyboard, Chords, and Chord Recognition are features that only 
become active once you have registered.    See Registration for more information.)



Audition Chord

From the Chord submenu of the Audition Keyboard submenu, you can select a 
chord that will be played when you click on the audition keyboard with the mouse.    A chord 
is just a special combination of keys, so through experimentation, you can find nice sounds 
for your own compositions.

See also:
Chord Recognition
Auditioning a Patch

(Note that the Audition Keyboard, Chords, and Chord Recognition are features that only 
become active once you have registered.    See Registration for more information.)



Chord Recognition

Instead of selecting a chord to play when you click on the Audition Keyboard with 
the mouse, you can select Chord Recognition for when you use an external MIDI keyboard 
to audition patches.    If chord recognition is turned on, PatchEZE will attempt to detect a 
musical chord every time you play a note on your MIDI keyboard, and if one is detected, it 
will be shown in the audition keyboard window.

If more than one chord is being played, PatchEZE displays the chord having the most 
number of component keys.    If the chords being played have the same number of keys, 
then the one with lowest pitch is detected.

See also:
Audition Chord
Auditioning a Patch

(Note that the Audition Keyboard, Chords, and Chord Recognition are features that only 
become active once you have registered.    See Registration for more information.)



MIDI Input Device

Early versions of PatchEZE only enabled you to use an external MIDI keyboard if it 
was connected to your UltraSound cards MIDI port.    However, if you have conflicts in your 
system that prevent you from using the UltraSound port, or if you prefer to use a different 
MIDI input port, you may like to select a different device to use for input.    If you have more 
than one available input device, you can switch between them with the MIDI Input Device 
submenu of the Options menu.

(Note that the option of selecting between different MIDI input devices is a feature that only 
becomes active once you have registered.    See Registration for more information.)



DIRSET: The PatchEZE DOS Utility

Sometimes all you want to do is load a patch set, or switch the MIDI and PEMIDI 
directories to change whether the Gravis patches or your custom patches are the ones made
available.    Having to enter Windows just to do this would become very annoying, so the 
utility DIRSET is provided to perform these operations from DOS.    With DIRSET you can also 
map a custom or Gravis patch to a certain instrument.    (The same functionality as the Map 
Button and Gravis Button.)

The following syntactical information is also shown when you type DIRSET with the /? 
or /H parameter:

Usage:
DIRSET          [/S]          [/R±]          [/L filename]          [/M filename ins]          [/G ins]

/S Switches MIDI and PEMIDI directories (and updates PATCHEZE.INI).
Also, /SG forces MIDI dir to contain Gravis patches, /SC custom patches.

/R Forces the Revert To Gravis option (a + sign meaning on, a - sign meaning off), 
overriding the setting in PATCHEZE.INI. (Note: only meaningful when using /L 
to load a patch set)

/L Loads the patch set specified by filename (if no extension, PPS default)
/M Maps the patch specified by filename to the given instrument. Instrument numbers

are of form Mxxx or Pxxx for melodic or percussive instrument xxx respectively. 
If used with /L for loading a patch set, the mapping will be performed after the 
load.

/G Similar to /M, but maps the Gravis patch for the given instrument.
/?    /H Displays this help information. (Also works without '/' character)

Note: DIRSET looks for the file PATCHEZE.INI in the current directory, and the 
directory from which DIRSET.EXE is being run. You can alternatively specify the path to
PATCHEZE.INI with the PATCHEZEDIR environment variable.

eg: SET PATCHEZEDIR=C:\ULTRASND\PATCHEZE



Support: Contacting Software 
Hallucinations

If you ever need to contact Software Hallucinations with problems or queries to do 
with the running of PatchEZE, please do so using one of the two below methods.

Regular mail:
Technical Support
Software Hallucinations
3 Bridget Place
Shelley, Perth
WESTERN AUSTRALIA
6148

Internet email contact:
hallucin@iinet.com.au

If you are reporting a problem, please include details of your system and Windows 
configuration, and exactly what you were attempting to do when you experienced the 
problem.    Remember that the more information you include, the easier it is reproduce the 
problem.

See also:
Registration






